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INTRODUCTION
These Microsoft® Excel® tips and tricks 
are the best of the best. They’re the top 
performing tips of 2017, and have raked up 
the highest number of views. In fact, with a 
combined viewership of over 220 000, these 
tips deserve their own television channel.

We’ve conveniently placed them all together 
in this neat e-book so that you have easy 
access to them whenever you need them! 
Congratulations on making the smart 
decision to get your hands on a copy of this 
e-book, we hope you find the same value in 
these tips that nearly a quarter of a million 
others did. 

WITHOUT FURTHER ADO, HERE’S THE 
COUNTDOWN OF THE TOP 10 EXCEL TIPS 
AND TRICKS OF 2017.
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Calculating invoice due dates in Microsoft® Excel® is easy. If you have struggled to calculate invoice due dates before, your worries 
are over – in this tip we’ll show you how to do this quickly using the WORKDAY function. The WORKDAY function returns a number 
that represents a date, before or after a specified number of work days. You can use WORKDAY to exclude weekend or holidays 
when you calculate invoice due dates or expected delivery times.

Note: Download the sample workbook to practice this exercise

Applies To: Microsoft Excel 2007,2010 and 2013

1. With reference to the sample workbook; select cell E2.

2. Select the Formulas Tab then Date & Time.

3. From the Date & Time function list ; select WORKDAY.

4. Then enter C2 as the start date and D2 as Days.

Tip #10: How to Quickly Calculate Invoice Due Dates
View count: 12 861 Views

http://www.sageintelligence.com/Email%20Resources/PDFs/Calculating%20the%20Invoice%20Due%20Dates%20in%20a%20Flash.xlsx
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•	 Start_date: A date that represents the start date. (required)
•	 Days: The number of working days before or after start_date. A positive value for days yields a future date; a negative value 

yields a past date. (required)
•	 Holidays: A list of one or more dates to exclude from the working calendar. The list can be  a range of cells that contain the 

dates.(optional)

5. Select OK and copy the formula down to cell E8.

6. The value returned by WORKDAY function should be converted to a date as follows.

•	 Right click on the value
•	 Select Format Cells
•	 Select Date under categories
•	 Select the Date type
•	 Select OK

•	 The due date has been returned for each Invoice number
•	 The due date excludes weekends or holidays
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Tip #9: How to use the Excel PMT Function to calculate the 
monthly repayment on a loan

The Excel PMT (payment) function is a really simple to use but highly useful financial function used to calculate the repayment 
amount on a loan. This function assumes that payments are made consistently (repayment frequency and amount remain 
constant) at a constant interest rate.

The video tutorial below will walk you through using the PMT function (a full transcript of the video is below):

PMT Function Tip Video Transcript:
The PMT function is used to calculate the payment required per period for loans based on constant payments at a constant 
interest rate. The periods themselves can be monthly, weekly or every two weeks. However, it must remain consistent with your 
payment period.

The PMT function: =PMT(rate, nper, pv, [fv], [type])

The PMT function requires:
•	 Rate – Your Interest Rate
•	 NPER – The Number of Periods over the Total Life of the Loan
•	 Pv – Your Present Value

It has two optional values:
•	 [fv] – Your Future Value
•	 [type]

The ‘Type’ lets you know whether the payment is going to be made on the first day of the month, or the last day of the month which 
is important for the calculation of interest. You can use the Future Value function to allow you to calculate the payment required 
to meet a savings target.

Using the PMT function:
Here is a spread sheet we have set-up already with a number of values that we can use to calculate our payment amount.

You are welcome to download the workbook to practice.

The first thing that we need to do is calculate our interest amount for each of the months. This particular repayment plan is going 
to happen on a monthly basis so we need to work out what the interest would be per month.

I take my interest rate (12% in cell C5) and divide it by 12 (number of months in a year). The Result is 0.01. The number of payments 
over the lifetime of this loan would be 5 years (Loan Years in cell C4) multiplied by 12 which would give you 60 periods.

The present value, I can reference from cell F3 (i.e. $100 000). I can now calculate my PMT function.
I reference my rate (cell B9), the number of periods (cell C9), and the present value(cell D9).
=PMT(B9, C9,D9)

Future Value and Type are in square brackets [] which mean these are optional parameters. I now have my monthly repayment of 
-$2,224.44. You’ll see that the value is represented as a negative value; this is because this is money going away from us in order to 
pay off this loan.

It will then be a simple matter to work out the entire amount paid for the life of the loan. I take my monthly payment (cell E9) and 
multiply it by the number of payments that I need to make (cell C9).
=E9*C9 (The Result is -$133,466.69)

The PMT Function works if the interest rate is constant over the life of the loan and the period repayment plan is also constant for 
the entire life of the loan.

Watch video now

View count: 12 865 Views

http://www.sagedl.com/sage-email/PDFs/IPMT%20function.xlsx
https://youtu.be/4twZ0llqEb0
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Tip #8: How to find the position of a value in a data range 
using the MATCH function

This tip is about the MATCH function and how it can be used to return the relative position of a value within a range. If you are in 
Sales, you can use the MATCH function to find the position of a sales value within a data range.

The MATCH function searches for a specified item in a range and then returns the relative position of that item in the range. Use 
MATCH, instead of one of the LOOKUP functions, when you need the position of an item in a range, instead of the item itself.

Note: Download the sample workbook to practice this exercise.

Applies to: Microsoft Excel 2007, 2010 and 2013

The screen shot below will be used for this example. Note that the list is sorted by the Product Sales column, in ascending order.

1. Select cell F20.

2. Select the Formulas tab and Lookup & Reference as below.

3. Then select MATCH from the drop down list.

View count: 16 819 Views

http://www.sageintelligence.com/Email%20Resources/PDFs/MATCH%20FUNCTION.xlsx
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4. Enter the formula arguments as shown below.

The MATCH function syntax has the following arguments:

•	 Lookup_value Required. The value that you want to match in lookup_array
T    The lookup_value argument can be a value ,cell reference to a number, text, or logical value

•	 Lookup_array Required. The range of cells being searched.
•	 Match_Type  Optional. The number -1, 0, or 1.

5. Select OK.

6. To create a drop down list for the values
a) Select cell F21 and then select the Data tab and Data Validation as shown below.
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7. The Data Validation pop-up will appear, In the Settings tab, select the options and input the source as shown below and select 
OK.

8. A drop down list will be inserted which will allow you to see where a selected amount (value) is positioned.
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Tip #7: How to extract text from a text string using the MID 
and FIND functions

Let’s say you have imported a list of names into Microsoft® Excel® from a payroll program, and the first names and surnames are 
all added to one column of data but in order to manipulate the data you would like to have the surnames extracted to a separate 
column. You can do this using various methods of extracting text from a text string. In this tip we show you how, by nesting the 
MID and FIND functions, the surname can be extracted from the name string.

•	 The MID function returns a specific number of characters from a text string, starting at the position you specify.
•	 The FIND function locates one text string within a second text string, and returns the number of the starting position of the 

first text string from the first character of the second text string.

Note: Download the sample workbook to practice this exercise.
Applies to: Microsoft Excel 2007, 2010 and 2013.

The screen shots below will be used to illustrate this exercise.

1. Select cell C3.

2. Select as per screen shot below.

3. Select MID from the Text functions list.

View count: 20 869 Views

http://www.sageintelligence.com/Email%20Resources/PDFs/MID-FIND%20FUNCTION%20EXAMPLE.xlsx
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4. Then enter the formula as below.

B3 refers to the first cell under the names column

•	 Excel searches for the position of the space within the text string using the FIND function.
•	 1 is added to the returned number. This is the first letter of the surnames.
•	 10 is the maximum number of characters that can be extracted.

5. Select OK and copy the formula down.

6. The result will be as below.

 



12

Tip #6: How to consolidate data in Excel using Data 
Consolidation

To summarize and report results from data on separate worksheets, you can consolidate the data from each separate worksheet 
into one worksheet (or master worksheet). The worksheets you consolidate can be in the same workbook as the master 
worksheet or in other workbooks.

When you consolidate data in one worksheet, you can easily update and combine it. For example, if you have a worksheet of 
expense figures for each of your regional offices, you might use data consolidation to combine these figures into a corporate 
expense worksheet. This master worksheet might contain sales totals and averages, current inventory levels, and highest selling 
products for the whole business.

In this tip we are going to consolidate income statements using data from branch A and branch B.

You are welcome to download the workbook to practice this exercise

Applies To: Microsoft Excel 2010 and 2013

1. Select the consolidation worksheet.

2. To consolidate branch A income statement data:
•	 Select cell A3.
•	 On the Data tab, in the Data Tools group, click Consolidate.

•	 In the Function box, click SUM.
•	 In the Reference box, click the Collapse Dialog button (edit reference icon) and select the branch A worksheet.
•	 Select the data range A3:B27.

•	 Click the Collapse Dialog button
•	 In the Consolidate dialog box, click Add .The branch A income statement data will be added to the reference list.

View count: 21 622 Views

http://www.sagedl.com/sage-email/PDFs/29.10.2015_How%20to%20consolidate%20data%20using%20the%20data%20consolidation%20method.xlsx
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3. To consolidate branch B income statement data:

•	 In the Reference box, click the Collapse Dialog button and select the February income statement.
•	 Select the data range A3:B27.
•	 Click the Collapse Dialog button
•	 In the Consolidate dialog box, click Add. The branch B income statement data will be added to the reference list.

4. Select the check boxes under Use labels in, (this indicate where the labels are located in the source ranges): Top row and Left 
column.

5. Tick the create links to source data check box.

6. Click OK.

As you can see a summary income statement has been created for the both branches. You can therefore analyse the financial 
performance of the organisation at a glance.

Below we’ll explain a few ways to consolidate data:
•	 Consolidate by position: Use this method when the data from multiple source areas are arranged in the same order and uses 

the same row and column labels. For example, when you have a series of expense worksheets that are created from the same 
template.

•	 Consolidate by category: Use this method when the data from multiple source areas is arranged differently, but the same row 
and column labels are used. For example, you can use this method when you have a series of inventory worksheets for each 
month that use the same layout, but each worksheet contains different items or a different number of items
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From Excel 2010, there’s a way to automatically highlight upcoming and past due dates. For example, if you have expiry dates for 
stock in a spreadsheet, it’s possible to highlight the stock that has expired as well as the stock that will expire within 30 days. This 
is achievable with conditional formatting. Below is a demonstration of how this can be done.

You’re also welcome to download the workbook to practice.

1. Select the Home tab in the toolbar at the top of the screen.

2. Then in the styles group, click on the Conditional Formatting drop-down and select Manage Rules.

3. When the Conditional Formatting Rules Manager window appears, click on the New Rule button to enter the first condition.

�

4. When the New Formatting Rule window appears, select the Format only cells that contain rule type. Then select Cell Value in 
the first drop down, less than in the second drop down, and enter the following formula: =NOW()+30

Next, we need to select what formatting to apply when this condition is met. To do this, click on the Format button:

Tip #5: Automatically highlight upcoming and past due 
dates
View count: 21 961 Views

http://www.alchemex.com/Email%20Resources/PDFs/Stock%20List.xlsx


15

5.  When the Format Cells window appears, select the Fill tab. Then select the color that you would like to use for the dates that 
will expire in the next 30 days. In this example, we’ve selected green. Then click on the OK button.

6.  When you return to the New Formatting Rule window, you should see the preview of the formatting in the preview box. In this 
example, the preview box shows green as the fill color. Click on the OK button.

This will return you to the Conditional Formatting Rules Manager window. Select OK.
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The stock that has already expired, as well as the stock that will expire in less than 30 days from now, will be highlighted in green.

This is an easy and effective way of automatically highlighting upcoming and past due dates in Excel.
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Tip #4: How to expand and collapse grouped columns 
using keyboard shortcuts

Grouped columns and rows (sometimes called Outline Data) are an alternative for hiding and showing data without using the 
Hide and Unhide function. Both options are great for organizing and de-cluttering worksheets which have a lot of data on display. 
Did you know that you can expand and collapse grouped columns using keyboard shortcuts? Follow the steps below to see how.

You are welcome to download the workbook to practice this exercise.

Applies To: Microsoft® Excel® 2010 and 2013

1. Open the exercise workbook. You will see that three columns (B, C and D) are grouped together.

  

2. Select any cell in those three columns, then press ALT, A, H.

The grouped rows are now in a collapsed view.

View count: 22 219 Views

http://www.sagedl.com/sage-email/PDFs/Demo%20-%20Expand%20and%20Collapse%20Grouped%20Columns.xlsx
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3. In order to expand the selection, you must select a cell in the same column as the group symbol (in this case, column E).

4. Press ALT, A, J.

The grouped columns are now expanded.
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Tip #3: Easy steps to opening an Excel workbook on a 
specific worksheet

Assuming you have one frequently used Microsoft® Excel® worksheet in a big workbook, wouldn’t you prefer to land on that 
specific worksheet when opening the workbook? By creating the simple macro given below, one can land on a specific Excel 
worksheet and even a specific cell when opening a workbook.

Follow these easy steps below as we explain how this can be done. 

Applies To: Excel 2003, 2007, 2010, 2013, and 2016

Visual Basic Coding: 
Private Sub Workbook_Open()
Sheets(“Sheet1”).Select
Range(“A1”).Select
End Sub 

1. Open Microsoft Excel, then press Alt + F11 (This will open the VISUAL BASIC Editor).

2. On the far left, under Microsoft Excel Object, select ThisWorkbook.

3. Then on the right hand side, paste the above code.

4. In the second line of the code, change Sheet1, to the sheet name (tab) you wish to land on.

5. In the third line of the coding, change A1, to the cell you wish to land on.

6. From the Menu bar, select File, Close and Return to Microsoft Excel, then save and close the Microsoft Excel workbook.

7. Ensure you save the workbook as an Excel Macro-Enabled Workbook. (*.xlsm)

The next time you open the workbook, it will open on the specific worksheet and cell.

To set your Macro security level, follow the steps below:
•	 On the Office/File tab, select Options.
•	 On the left side of the dialogue box,select Trust Centre, then select the Trust Centre Settings button.
•	 On the left side, select Macro Settings, then select Disable all macros with notification.

By landing on a specific worksheet and or cell, you will time by navigating to a desired location within your Excel workbook, thus 
making streamlining your process and making it more efficient.

N.B. Ensure that your Macro Settings are not disabled under the Macro Settings Option . 

View count: 24 122 Views
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Tip #2: Easily recover an unsaved workbook in Excel

If you’ve experienced the mishap of mistakenly closing a file while working on it, or losing it due to a power failure or gremlin in 
your computer, you’ll know how frustrating it can be. Fortunately, changes were made in Microsoft® Excel® 2010 and 2013 which 
make the process to recover an unsaved workbook much simpler.

To take advantage of these changes, you need to have the following options enabled:
•	 Save auto recover information
•	 Keep the last autosaved version if I close without saving

Applies To: Microsoft Excel 2007, 2010 and 2013

1. To enable the Save auto recover information options:
a) Select File
b) Select Options
c) Select Save and tick the Save AutoRecover boxes as shown below.

2. Select the File menu tab and Info option.

View count: 28 149 Views
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3. On the info page, click on the Manage Versions button

4.  Select Recover Unsaved Workbooks

5. Select the respective file and click Open

 The unsaved version of the workbook will be opened, thus no data will be lost
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Tip #1: How to delete a worksheet quicker using 
keyboard shortcuts

To delete a worksheet in a Microsoft® Excel® workbook, you would normally right-click on the worksheet tab and select ‘Delete’. 
However, to save you a bit of time, you can do it quicker using a keyboard shortcut combination that will execute the same 
command.

You are welcome to download the workbook to practice this exercise.

Applies To: Microsoft Excel 2003, 2007, 2010 and 2013

1. Open the workbook. There are three sheets, however we wish to delete the second and third sheets (Sheet2 and Sheet3 
respectively).

2. Select Sheet2.

View count: 31 462 Views

http://www.sagedl.com/sage-email/PDFs/Delete%20Sheet%20Demonstration.xlsx
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3. Press ALT + E, then the L key.

4. Select Delete in the Confirm Deletion window. The sheet will now be deleted.

5. Sheet3 will now be selected. Press F4 to repeat your last command, and you will be able to delete this sheet as well.

The F4 keyboard shortcut repeats the last command. This shortcut will also apply if you choose to use the right-click deletion 
method.

Note: Microsoft Excel 2010 and 2013 have a new keyboard shortcut for deleting a sheet – Alt + H, D, S. However, they will still 
recognise the original version, which involves one less keystroke.
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Can’t get enough of these time-saving tips? Why not join 
the list for our weekly Excel Tips and Tricks newsletter, 
where you’ll receive a handy tip or trick delivered straight 
to your inbox every Thursday!

Join List

And if that still doesn’t quench your thirst for business 
reporting knowledge, you can check out our other 
guides and e-books that help you make better business 
decisions, by opening your eyes to the importance of 
complete business visibility. 

Go To Resources

CONCLUSION

Don’t forget to also follow and 
engage with our resident business 
intelligence thought-leader, Charles 
Teversham. You’ll be kept in the 
loop on all things business reporting 
related, and regularly learn of new 
and exciting advances in the industry.

Follow

https://www.linkedin.com/in/charles-teversham/
https://twitter.com/CTeversham
https://www.sageintelligence.com/subscribe/xl/
https://www.sageintelligence.com/ebooks/


©2017 Sage Software, Inc. All rights reserved. Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc.,  
or its affiliated entities. All other trademarks are the property of their respective owners.

Sage
Sage Technology Park
102 Western Service Park
Gallo Manor
+27 (0)11 304 1000
Sage.com


